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Preface
Thank you for purchasing the BMW 
Motorrad zūmo™. 

Manual Conventions
When you are instructed to “touch” 
something, use your finger to touch an 
item on the screen. You will see arrows 
(>) used in the text. They indicate that 
you should touch a series of items. For 
example, if you see “touch Where to > 
Favorites,” you should touch the Where 
to button, and then touch Favorites. 

Contact Garmin
Contact Garmin if you have any 
questions while using your zūmo. In 
the USA, contact Garmin Product 
Support by phone: 913/397.8200 or 
800/800.1020, Monday–Friday, 8 AM–5 
PM Central Time; or go to www 
.garmin.com/support, and click Product 
Support.

In Europe, contact Garmin (Europe) Ltd. 
at +44 (0) 870.8501241 (outside the UK) 
or 0808 2380000 (within the UK).

myGarmin™ 
Go to http://my.garmin.com to access the 
latest services for your Garmin products. 
From the myGarmin Web site, you can:
• Register your Garmin unit.
• Subscribe to online services for safety 

camera information (see page 47).
• Unlock optional maps.
Return to myGarmin often for new 
Garmin product services. 

About Google Earth™ 
Go to http://earth.google.com to 
download the Google Earth application. 
With Google Earth installed on your 
computer, you can view waypoints, 
tracks, and routes saved in MapSource®. 
From the View menu, select View in 
Google Earth.

www.garmin.com/support/
www.garmin.com/support/
http://my.garmin.com
http://earth.google.com
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 Important Information

See the Important Safety and Product Information guide in the product box for  
product warnings and other important information.

Declaration of Conformity
Hereby, Garmin declares that this product is in compliance with the essential 
requirements and other relevant provisions of Directive 1999/5/EC. 
To view the full Declaration of Conformity, see the Garmin Web site for your 
Garmin product: www.garmin.com/BMWzumo. Click Manuals, and then select 
the Declaration of Conformity.

www.garmin.com/products/zumo/
www.garmin.com/BMWzumo
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GettinG Started

Looking at Your zūmo
A.   Power button
B.  Zoom in, raise volume, or 

increase brightness.
C.  Zoom out, lower volume, or 

decrease brightness.
D.  Page button—scroll 

through the Map, Compass, Trip 
Information, Media Player, and 
Phone Menu pages. Press and 
hold to adjust brightness. 

E.  Speak button—
press to adjust volume 
level. Press and hold 
to announce voice 
directions.

SD card 
slot

M�n�-USB port for AC power, 
USB Mass Storage mode, and 

updat�ng software

A

B
C

D
E

MCX connector 
under weather 
cap (see page 

50)

Battery pack
(see page 49)
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zūmo Tips and Shortcuts
• Touch and hold  to quickly 

return to the Menu page.
• Press  to return to the map. 
• Touch  and  to see more 

choices.
• Touch  to adjust settings such 

as volume, brightness, language, and 
keyboard.

Adjusting the Volume
Press , and then use  and  to 
adjust the volume. For advanced volume 
settings, touch  > Volume. 

Adjusting the Brightness
Press and hold , and then use  
and  to adjust the brightness. See 
page 41 for additional display settings.

Quick Links
• Finding an address: page 7
• Viewing the map: page 16
• Using hands-free mobile phone 

features: page 19
• Using the Garmin Lock™  

anti-theft feature: page 6
• Listening to MP3 files: page 32 
• Transferring files to your zūmo: 

pages 29–31
• zūmo audio options, see page 43
• Cleaning and storing your zūmo: 

page 50

Fill out the product documentation 
survey. Go to www.garmin.com/ 
contactUs, and click Product 
Documentation Survey. 

http://www.garmin.com/contactUs/
http://www.garmin.com/contactUs/
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Configuring Your zūmo
To turn on your zūmo, press and hold . Follow the on-screen instructions to 
configure your zūmo. 

Acquiring Satellites
Go outdoors to an open area, out of garages, and away from tall buildings. Stop your 
vehicle, and turn on the zūmo. Acquiring satellite signals may take a few minutes. 
The  bars indicate GPS satellite strength. When the bars are green, your zūmo 
has acquired satellite signals, and you can start navigating. 

Using Your zūmo
A. Displays satellite strength.
B. Displays phone and headset connection 

status. 
C. Displays battery status. 
D.	 Touch to find a destination. 
E.	 Touch to view the map. 
F. Touch to open the Phone menu (when 

connected to a mobile phone with 
Bluetooth® wireless technology).

G. Touch to view traffic incidents (requires 
GTM™ 12 and subscription).

H. Touch to open the Media 
Player.

I. Touch to adjust the zūmo’s 
settings.

A B C

D E

F G H I
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Finding Your Destination 
The  Where to menu provides several different categories for you to use when you 
search for locations. 

➍Select a destination.  Enjoy the route! ➏Touch Go.➎

➌	➋➊ Select a sub-
category. 

Select a category. Touch  Where to.

TiP: Touch  and  to see more choices.
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Following Your Route
As you travel, your zūmo guides you 
to your destination with voice prompts, 
arrows on the map, and directions at the 
top of the map. If you depart from the 
original route, your zūmo recalculates 
the route and provides new directions. 

A checkered flag marks your dest�nat�on.

Your route �s marked w�th a purple l�ne.  
Follow the arrows as you take turns.

Adding a Stop
You can add a stop (via point) to your 
route. The zūmo gives you directions to the 
stop and then to your final destination. 

 TiP: If you want to add more 
than one stop to the route, 
consider editing the active route. 
See page 12.

1. With a route active, touch Menu on 
the map, and touch  Where to. 

2. Search for the extra stop. 
3. Touch Go.
4. Touch Add as Via Point to add this 

stop before your destination. Touch 
Set as new Destination to make this 
your new final destination. 
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Adding a DetourDetour
If a road on your route is closed, you can 
take a detour. 
1. With a route active, touch Menu. 
2. Touch Detour. 

Stopping the Route
1. With a route active, touch Menu. 
2. Touch Stop. 

Locking Your zūmoocking Your zūmo
1. Touch  >  System > 

Garmin Lock. 
2. Touch OK, and enter a four-digit PIN. 
3. Re-enter your four-digit PIN. 
4. Touch OK. 
5. Drive to a security location, and touch 

Set.
Each time you turn on the zūmo, enter 
the four-digit PIN or drive to the security 
location. 

What is a Security Location?
You can select any location, such as 
your home or office, for your security 
location. If you are at your security 
location, you do not need to enter a PIN. 
If you forget your PIN, drive to your 
security location to unlock the zūmo. 

	NoTE: To unlock your zūmo at 
your security location, the zūmo 
must have acquired satellite 
signals. 

	NoTE: If you forget your PIN 
and your security location, you 
must send your zūmo to Garmin 
to get it unlocked. You must also 
send a valid product registration 
or proof of purchase.
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 Where to
The Where to menu provides several 
different categories you can use to search 
for locations. To learn how to perform a 
simple search, see page 4. 

Finding an Address
1. Touch  Where to >  Address. 
2. Select a country, state/province, and 

city/postal code, if necessary.
3. Enter the address number, and touch 

Done. 
4. Enter the street name until a list of 

streets appears, or touch Done.
5. Select the street and city, if 

necessary.
6. Select the address, if necessary. The 

Go page opens. 
7. Touch Go to create a route to this 

address. 

TiP:  Do not enter the street prefix 
or suffix. For example, to find North 
Main Street enter Main, and to find 
Highway 7 enter 7. 

About Postal Codes
You can search for a postal code. Enter 
the postal code instead of the city name. 
Not all map data provides postal code 
searching.

Intersections
Finding an intersection is very similar 
to finding an address. Touch  
intersection, and enter the two street 
names. 

Go Page Options
Touch an item in the search results list to 
view the Go page. 
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Touch Go to create a turn-by-turn route 
to this location. 
Touch Show Map to view this location 
on the map. If the GPS is off, touch  
Set Loc. to set this as your current 
location. 
Touch Save to save this location as one 
of your Favorites. See page 10. 
If a mobile phone with Bluetooth 
wireless technology is connected, touch 

 to call this location.

Go Home
You can set a home location for the place 
you return to most often. 
1. Touch  Where to >  Go Home.
2. Select an option. 
Going Home
After you set your home location, you 
can route to it at any time by touching  

 Where to >  Go Home.

Changing Your Home 
Location
1. Touch  >  User Data > Set 

Home Location.
2. Select Yes, enter my Address or 

Yes, use my current location. 

Finding Points of Interest
1. Touch  Where to >  Food, 

Hotels.
2. Select a category and a sub-category, 

if necessary. (Touch the arrows to see 
more categories.) 

3. Select a destination. 
4. Touch Go.
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Finding a Location by 
Spelling the Name 
If you know the name of the location you 
are looking for, you can spell it using the 
on-screen keyboard. You can also enter 
letters contained in the name to narrow 
the search. 
1. Touch  Where to >  Food, 

Hotels.
2. Touch Spell Name.
3. Using the on-screen keyboard, enter 

letters in the name. Touch Done. 
4. Touch the location you are looking 

for, and touch Go.

Using the On-Screen 
Keyboard
Touch and slide the yellow box to view 
the characters. Touch a character button 
to enter it. 

TIP: Tap anywhere on the alphabet 
row to qu�ckly move the yellow box.

Touch  to delete the last character 
entered; touch and hold  to delete the 
entire entry. 
Touch  to change the keyboard 
mode to use diacritical characters or 
special characters.
Touch  to enter numbers. 
To change the keyboard display, see 
page 42.
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Recently Found Locations
Your zūmo stores the last 50 of your 
recent finds in the Recently Found list. 
The most recently viewed locations 
appear at the top of the list. Touch  
Where to >  Recently Found to 
view your recently found items. 
Touch Save > oK to add a recently 
found location to your  Favorites. 
Touch Clear > Yes to delete all locations 
from the Recently Found list.  

	NoTE: When you delete recently 
found locations, all items are 
removed from the list. It does not 
delete the actual location from 
your unit.

Favorites
You can save up to 500 locations in your 
Favorites, so you can quickly find them 
and create routes to them. Your home 
location is also stored in Favorites. 

Saving Locations You Find
1. After you have found a location you 

want to save, touch Save. 
2. Touch OK. The location is saved in 

 Favorites. 

Sharing Locations
Share your Favorites with other zūmo 
owners. You must insert an SD card with 
available storage space. 
1. Touch  Where to >  Favorites.
2. Select the location you want to share.
3. Touch Share.
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4. Verify that the correct location is 
selected, and then touch Export.

5. Touch OK.
6. Eject your SD card, and insert it into 

another zūmo.
7. A message appears. Touch Yes to 

import the shared locations.
8. Touch Favorites, and then touch the 

location you want to import.

9. Touch Import, and then touch OK.
10. Touch Done to go back to the Menu 

page. 

Finding Saved Locations
Touch  Where to >  Favorites. 
The locations are listed by distance from 
your current location. Touch Spell to 
narrow your search.

Saving Your Current Location
From the map, touch the  vehicle 
icon. Touch Yes to save your current 
location as a Favorite. 
Editing Saved Locations
1. Touch  Where to >  Favorites. 
2. Touch the location you want to edit. 
3. Touch Edit. 

4. To edit the location:
Touch Change Name. Enter a name, 
and touch Done. 
Touch Change Map Symbol. Touch 
a symbol.
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Touch Change Phone Number. Enter 
a phone number, and touch Done. 
Touch Delete to remove this item. 
A list of all your Favorites appears. 
Touch the item you want to delete. 
Touch Delete > Yes. 

Creating a Saved Route
Use your zūmo to create and save routes 
before your next trip. You can save up to 
50 routes.
1. Touch  Where to >  Routes > 

New.
2. Touch Add New Start Point.
3. Find a location as your starting point, 

and touch Select.
4. Touch Add New End Point.
5. Find a location as your ending point, 

and touch Select.

6. Touch  to add another location to 
your route. TIP: Touch Near to narrow 
your search, see page 15. Touch  
to remove a location. 

7. Touch Map to calculate your route, 
and view it on the map.

8. Touch Back to exit and save the 
route. 

Editing Saved Routes
1. Touch  Where to >  Routes.
2. Select the route you want to edit.
3. Touch Edit.
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4. To edit the route:
• Touch Change Name. Enter a new 

name, and touch Done. 
• Touch Add/Remove Points to add 

new start, via, or end points to the 
route.

• Touch Manual Reorder to change 
the order of points along your route.

• Touch Optimal Reorder to 
automatically order the points 
according to straight line distance 
between your start and end points. 

• Touch Recalculate to change the 
route preference to calculate by faster 
time, shorter distance, or off road.

• Touch Delete to remove this item. A 
list of all your routes appears. Touch 
the item you want to delete. Touch 
Delete > Yes. 

	NoTE: Your changes are 
automatically saved when you 
exit any of the route edit pages.

Sharing Routes
Share your saved routes with other zūmo 
owners. You must insert an SD card with 
available storage space. 
1. Touch  Where to >  Routes.
2. Select the route you want to share.
3. Touch Share.

4. Verify that the correct route is 
selected, and then touch Export.

5. Touch OK.
6. Eject your SD card, and insert it into 

another zūmo.
7. A message appears. Touch Yes to 

import the shared route.
8. Touch Routes, and then touch the 

route you want to import.
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9. Touch Import, and then touch OK.
10. Touch Done to go back to the Menu 

page. To view your imported routes, 
touch  Where to > Routes.

	NoTE: You can also share routes 
using Google Earth. Go to  
http://earth.google.com. 

Finding a Location UsingUsing  
the Map
Touch  View map to open the map.  
Touch and drag anywhere on the map to 
browse and view different parts of the 
map. You can also touch  Where to > 

 >  Browse Map. 

Tips for Browsing the Map
• Touch the map and drag to view 

different parts of the map. 
• Touch  and  to zoom in and out. 
• Touch any object on the map. An 

arrow appears pointing at the object 
you selected. 

• Touch Back to return to the previous 
screen.

• Touch Save to save this location to 
your  Favorites. 

• Touch Go to create a turn-by-turn 
route to the location. 

• If the GPS is off, touch Set Loc. to 
set the arrow location as your current 
location. 
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Entering Coordinates
If you know the geographic coordinates 
of your destination, you can use your 
zūmo to navigate to any location using 
its latitude and longitude coordinates. 
Touch  Where to >  >  
Coordinates. 

Touch Format to change the type of 
coordinates. Because different maps and 
charts use different position formats, the 
zūmo allows you to choose the correct 
coordinate format for the type of map 
you are using.
Touch Next for more options: 
• Touch Go to create a turn-by-turn 

route to the coordinates.
• Touch Show Map to view this 

location on the map.

• Touch Save to save this location to 
your  Favorites.

Expanding Your Search
1. Touch  Where to > Near.
2. Select an option:

Where I Am Now—searches near 
your current location. 
A Different City—searches near the 
city you specify. 
My Current Route—searches along 
the route you are currently navigating.
My Destination—searches for 
locations near your current route 
destination.

3. Touch OK.

	NoTE: Your zūmo automatically 
searches near your current 
location. 
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USinG the Main PaGeS

Map Page
On the Menu page, touch  View map to open the map. The  vehicle icon 
shows your current location. 

Map Page while Navigating a Route

Touch Speed to open 
the Tr�p Informat�on 

page. 

Touch Turn In to open 
the Next Turn page. 

Touch the d�rect�ons 
bar to open the Turn 
L�st page. 

Touch  to zoom out.

Touch  to zoom �n.
Touch Menu to return 

to the Menu page.

Touch the veh�cle �con to v�ew your current coord�nates and 
elevat�on. Then touch Yes to save th�s locat�on. 

Turn List Page Next Turn PageTrip Information Page
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Trip Information Page
The Trip Information page shows your 
current speed and provides helpful 
statistics about your trip. To view the 
Trip Information page, touch Speed on 
the map. 

Resetting Trip Information
If you want accurate trip information, 
reset the trip information before 
beginning a trip. If you make frequent 
stops, leave the zūmo turned on so it can 
accurately measure elapsed time during 
the trip. 
Touch Reset to reset the odometers (A 
and B), maximum speed, trip data, fuel 
gauge, and miles per tank.
Touch More to view speed data and 
travel time data.

Using the Fuel Gauge
The fuel gauge is for motorcycle use 
only. You can track your fuel usage when 
the zūmo is in the motorcycle mount. 
The fuel gauge is only as accurate as the 
data you enter. 
1. On the map, touch Speed to open 

the Trip Information page. 
2. Touch Reset > Miles Per Tank.
3. Enter an amount, and touch Done.
4. A message appears when you have 

30 miles (~48.3 km) remaining.

5. On the map, touch the  icon to 
search for a nearby fuel station. 
Touch OK.

6. To reset the fuel gauge, go 
to the Trip Information page, 
and touch the fuel gauge > 
Yes.
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Turn List Page
When you are navigating a route, the 
Turn List page shows turn-by-turn 
instructions for your entire route and 
the distance between turns. Touch the 
directions bar on the top of the map to 
open the Turn List page. Touch a turn on 
the list to view the Next Turn page for 
that turn. Touch Show Map to view the 
entire route on the map. 

Next Turn PageTurn Page
To view an upcoming turn on the map, 
touch Turn in on the map, or touch any 
turn from the Turn List page. When you 
are navigating a route, the Next Turn 
page shows the turn on the map and the 
distance and time left before you reach 
the turn. Touch  and  to view 
other turns in the route. 

Compass Page
To view the Compass page, touchCompass page, touch 
Driving on the map or press . 

Bear�ng 
po�nter

Bug 
�nd�cator

Data 
fields

When you are navigating a route, the 
compass rotates and the bug indicator 
shows the direction you should be 
travelling to stay on the route. The 
bearing pointer indicates your current 
direction. If the arrow points up, you 
are going directly to the destination. If 
the arrow points any other direction, 
navigate the direction of the bug 
indicator until the arrow points up. 
Touch More to see additional data fields. 
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USinG handS-free 
featUreS

Using Bluetooth® wireless technology, 
your zūmo can connect to your mobile 
phone and wireless headset to become a 
hands-free device. To see if your device 
with Bluetooth technology is compatible 
with the zūmo, visit www.garmin.com/ 
bluetooth.
Bluetooth wireless technology 
establishes a wireless link between 
devices, such as a mobile phone, 
wireless headset, and the zūmo. The 
first time you use two devices together 
you must “pair” them by establishing a 
relationship using a PIN/ passkey. After 
the initial pairing, the two devices can 
connect automatically each time you turn 
them on. 

 NoTE: You might have to 
set your device to connect 
automatically when the zūmo is 
turned on.

Why should I pair my 
phone and headset with 
my zūmo? 
To get the full features of the zūmo, 
you should pair your phone to the 
zūmo and also pair your headset to 
the zūmo. In addition to hands-free 
phone use, you can also hear zūmo 
navigation prompts through your 
headset. 
For additional zūmo audio options, 
see page 43.

Pairing Your Device
To pair and connect, your device and the 
zūmo must be turned on and be within 
10 meters of each other. 
Initiate pairing from your zūmo or 
from your mobile phone. Refer to your 
phone’s instructions.

www.garmin.com/bluetooth
www.garmin.com/bluetooth
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To pair using the zūmo settings:
1. On the zūmo’s Menu page, touch 

 >  Bluetooth.

2. Touch the Add button next to the 
“Connect Phone” or “Connect 
Headset” option. 

3. Enable your device’s Bluetooth 
component and enable Find Me/
Discoverable/Visible mode. These 
settings might be in a Bluetooth, 
Connections, or Hands-free menu.

4. Touch OK on the zūmo.
5. Select your device, and touch OK.
6. Enter the zūmo’s Bluetooth PIN 

(1234) in your phone, if necessary.
7. On the zūmo, touch and hold Back to 

return to the Menu page.

To pair using the phone settings:
1. Enable the phone’s Bluetooth 

component. This might be in a 
menu called Settings, Bluetooth, 
Connections, or Hands-free. 

2. Initiate a search for Bluetooth 
devices. This might be located in a 
menu called Bluetooth, Connections, 
or Hands-free.

3. Select the zūmo from the list of 
devices. 

4. Enter the zūmo’s Bluetooth PIN 
(1234) into your phone.

5. On the zūmo, touch and hold Back to 
return to the Menu page.

 NoTE: Each time you turn on 
the zūmo, it tries to connect to 
the last device with which it was 
connected.
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Getting a Call
When your phone is connected with 
the zūmo, the  icon appears in the 
upper-left corner. When your headset 
is connected with the zūmo, the  
icon appears in the upper-left corner.
When you get a call, the Incoming Call 
window opens. 

Touch Answer to answer the call. Touch 
ignore to ignore the call and stop the 
phone from ringing. 

In a Call
After you have made or answered a 
call, the  in Call icon appears on the 
screen. Touch  for more options:

Touch End Call to hang up.
Touch Call options view the following 
in call settings: 
Touch Tones—displays a keypad page 
so you can use automated systems, such 
as voice mail. 
Transfer Audio To Phone—to switch 
audio to your phone. This is helpful if 
you plan to turn off the zūmo, but want 
to stay on the call. You can also transfer 
a call to your phone if you need privacy 
or your headset is malfunctioning. To 
switch back, touch Transfer Audio To 
Device.
Mute Microphone—to mute the 
microphone during a call. It mutes a 
wired microphone, wireless headset 
microphone, or the internal microphone 
on the automotive mount.
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Using Call Waiting
 NoTE: If your phone does not 
support call waiting through 
Bluetooth, this feature will not 
work.

If you get a call during a call, the 
Incoming Call window appears. Touch 
Answer to answer the call. The first call 
is placed on hold. 

To switch between calls:
1. Touch  to open the In Call menu. 

2. Touch Switch To. 
3. Touch End Call to hang up; this does 

not disconnect the call on hold. 

Phone Menu
On the Menu page, touch  to open 
the Phone menu. Not all phones support 
all features of the zūmo Phone menu. 
Refer to your phone’s instructions. 

Press Status to view the connected 
phone’s signal strength, battery level, 
carrier, and name.
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Using Your Phone Book
 NoTE: The phone book feature 
is only available if your phone 
supports phone book transfer.

Each time your mobile phone connects 
with the zūmo, the phone book is 
automatically loaded into the zūmo. It 
may take a few minutes for the phone 
book to be available. 
1. Touch  >  Phone Book. 

2. Touch the phone book entry you want 
to call.

3. Touch Dial. 

Dialing a Point of Interest
1. Touch  >  Food, Hotels. 
2. Search for the point of interest you 

want to call. 

3. Touch Dial or .

Dialing a Number
1. Touch  >  Dial. 

2. Enter the number, and touch Dial.
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Viewing Your Call History
 NoTE: Call history is only 
available if your phone supports 
call history transfer.

Each time your phone connects to the 
zūmo, your call history is automatically 
transferred to the zūmo. It may take a 
few minutes to transfer this data to the 
zūmo.
1. Touch  >  Call History. 
2. Touch Missed, Dialed, or Received 

to view those calls. The calls are 
listed in chronological order; the most 
recent calls are at the top of the list. 

3. Touch an entry, and touch Dial.

Calling Home
Enter a phone number for your home 
location, so you can quickly call home. 
Enter a Home Phone Number
1. Touch  >  Call Home. 

2. Touch Enter Phone Number to use 
the keypad page or Select From 
Phonebook (only available if your 
phone supports phone book transfer).

3. Touch Done > Yes. The zūmo dials 
your home phone number.

	NoTE: To edit home location or 
phone number, touch  Where 
to >  Favorites > Home > 
Edit. 
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Call Your Home
 Touch  >  Call Home. The 

zūmo dials your home phone number.

Placing Calls Using Voice Dial
 NoTE: Voice dial is only 
available if your phone supports 
voice dialing.

You can place calls by speaking the 
contact’s name into the microphone. 
1. Touch  >  Voice Dial. 
2. Speak the contact name. 

	NoTE: You may need to “train” 
your mobile phone to recognize 
your voice commands. Refer to 
your phone’s instructions. 
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traffic inforMation
Your zūmo can receive and use traffic 
information using the GTM 12 FM 
TMC (Traffic Message Channel) 
traffic receiver. When a traffic message 
is received, your zūmo displays the 
incident on the map and can change 
your route to avoid the traffic incident. 
For participating FM traffic subscription 
providers and coverage cities, go to 
www.garmin.com/fmtraffic.

	NoTE: Garmin is not 
responsible for the accuracy of 
the traffic information. The GTM 
12 simply receives signals from 
the traffic service provider and 
displays that information on your 
zūmo. 

To install your GTM 12:
1. Connect your zūmo to external 

power.
2. Connect the mini-USB plug on the 

GTM 12 to the mini-USB port on your 
zūmo mount.

M�n�-USB 
port

Power 
cable

3. Secure the GTM 12 to your 
motorcycle. For best results, position 
the antenna vertically.

4. Route the GTM 12 cable so it does 
not interfere with your motorcycle’s 
operating controls.

www.garmin.com/fmtraffic
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Traffic in Your Area
On the Menu page, touch  > 
Traffic.

	NoTE: The FM traffic receiver 
and zūmo must be in data range 
of an FM station transmitting 
TMC data to receive traffic 
information. 

Traffic on Your Route
The map displays  or  when 
there is a traffic delay on your route. 
The number in the icon represents the 
delay time in minutes. The delay time is 
automatically calculated into the arrival 
time shown on the map. 
1. Touch   or  to view a map and 

more information.

2. Touch the yellow text bar for more 
information. If there is more than one 
delay, touch Details.

3. Touch Avoid to recalculate your route 
to avoid this delay.

Traffic Codes and Symbols
 Green = Low severity; traffic is 

flowing normally.
 Yellow = Medium severity; traffic is a 

bit congested.
 Red = High severity; traffic is heavily 

congested or stopped.
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North 
American Meaning International

Road 
condition

Road 
construction

Road closed

Slow traffic

Accident

Incident

Information

Purchasing Traffic 
Subscriptions
You can renew and purchase new 
subscriptions at www.garmin.com/
fmtraffic.

Adding a Subscription
1. Touch  >  > Traffic. 
2. Touch Subscriptions.
3. Touch Add.
4. Follow the on-screen instructions. 

http://www.garmin.com/fmtraffic
http://www.garmin.com/fmtraffic
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ManaGinG fileS on  
Your zūmo

You can load files to the internal memory 
or an optional SD card. 

	NoTE: The zūmo is not 
compatible with Windows® 95, 
Windows 98, or Windows Me 
operating systems. This is a 
common limitation of most USB 
Mass Storage Devices. 

Supported File Types
• MP3 music files
• M3U playlist files
• JPEG and JPG image files for splash 

screen or picture viewer
• GPI custom POI files from Garmin’s 

POI Loader
• GPX waypoint files and maps from 

MapSource

 NoTE: The zūmo does not 
support iTunes® M4A/M4P files. 

Step 1: Insert an SD Card 
(Optional)
To insert or remove the card, press it in 
until it clicks. 

SD card 
slot

M�n�-USB port for AC 
power, USB Mass Storage 

mode, and updat�ng 
software

Step 2: Connect the USBUSB 
Cable
1. Plug the small end of the USB cable 

into the mini-USB port. 
2. Connect the larger end of the USB 

cable to an available USB port on 
your computer. 
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Two additional drives appear in your 
computer’s list of drives. “Garmin” 
is the available storage in the zūmo’s 
internal memory. The other removable 
disk drive is the SD card. 

	NoTE: If the drive is not named 
automatically, see your Help file 
or page 54 to rename the drive. 

Step 3: Transfer Files to 
Your zūmo 
For Windows computers
1. Connect the zūmo to your computer. 
2. Double-click  My Computer. 
3. Browse your computer for the file you 

want to copy. 
4. Highlight the file, and select Edit > 

Copy. 
5. Open the Garmin drive or the SD 

card drive.

6. Select Edit > Paste. The file appears 
in the list of files on the Garmin or SD 
card drive. 

	NoTE: You can also drag and 
drop files to and from your 
drives. 

For Mac® computers
1. Connect the zūmo to your 

computer. Your Garmin 
and SD card drives should 
mount onto your Mac 
desktop as two mounted 
volumes.

2. To copy files to your Garmin or SD 
card drive, drag and drop any file or 
folder onto the volume icon. 

Volume 
icon
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Step 4: Eject and Unplug
For Windows computers
When you are finished transferring files, 
double-click the  Unplug or Eject 
icon in your Windows system tray. 
Select USB Mass Storage Device, and 
click Stop. Select the drive, and click 
oK. You can unplug the USB cable from 
your zūmo now. 

For Mac computers
When you are finished transferring 
files, drag the volume icon to the Trash 

 (it turns into an Eject  icon) to 
unmount the device. You can unplug the 
USB cable from your zūmo now.

Deleting zūmo Files
You can delete files from your zūmo 
just as you would delete files from your 
computer.
Connect the zūmo to your computer, 
and open your Garmin or SD card 
drive. Select the file that you want to 
delete, and press the Delete key on your 
computer’s keyboard. 

	CAUTioN: If you are not sure 
about a file’s purpose, do not 
delete it. Your zūmo memory 
contains important system files 
that should not be deleted. Be 
cautious of files located in folders 
entitled “Garmin.”
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USinG the Media 
Player

Listening to MP3 Files 
Load MP3 files to the internal memory 
or an optional SD card. See pages 29–31 
for more information.
1. On the Menu page, touch  to 

open the Media Player. 
2. Touch Source to view the MP3 

player.
3. Touch Browse.
4. Touch a category.
5. To play the entire category from the 

beginning of the list, touch Play All. 
To play all starting with a specific 
song, touch the title. 

Album art

Touch the album art to view details 
about the MP3 file.
Touch  to adjust the volume. For 
zūmo audio options, see page 43.
Tap  to go to the beginning of the 
song; touch and hold to skip back. 
Tap  to skip to the next song; touch 
and hold to skip ahead. 
Touch  to pause the song. 
Touch  to repeat. 
Touch  to shuffle. 

 NoTE: The zūmo plays MP3 
files only; it does not support 
iTunes®  M4A/M4P files. 
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Using a Playlist
This feature involves managing files on 
your zūmo (see pages 29–31).
1. Using your computer and an audio 

program such as Winamp™, create a 
playlist of MP3 files. 

2. Save the playlist as an M3U file. 

 NoTE: You may need to edit the 
M3U file with a text editor, such 
as Notepad, to remove the path 
(location) to the MP3. The M3U 
file should only list the MP3 files 
in your playlist, not their location. 
Refer to the audio program’s 
Help file for instructions.

3. Transfer the playlist and the 
associated MP3 files to the Garmin or 
SD card drive. The M3U file must be 
in the same location as the MP3 files.

4. On the zūmo, touch  > Source 
to open the MP3 player. 

5. Touch Browse > Import Playlist. 
The available playlists appear.

6. Touch a playlist to start playing the 
MP3 files. 

 NoTE: You cannot change the 
order of the playlist from your 
zūmo. 

Listening to Audible Books
To purchase books from Audible.com, 
go to http://garmin.audible.com. See 
page 34 to load books to your zūmo.
1. On the Menu page, touch  > 

Source to open the audible book 
player.

2. Touch Browse, and touch a category.
3. To play a book, touch the title.

http://garmin.audible.com
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Book 
cover art

Moving Around the Book
Touch  to adjust the volume.
Touch the book cover art to view more 
detailed information about the book. 
Touch  to skip a section and  to 
jump back. Press and hold those buttons 
to move forward or backward through 
the book. 
Touch  to pause the book. 

Using Bookmarks
To create a bookmark, touch  and 
Bookmark. To view your bookmarks, 
touch  and then touch a bookmark. 
Touch Play to listen to the book from the 
bookmark.

Loading Audible Books to 
Your zūmo
1. Create an Audible.com account at 

http://garmin.audible.com.
2. Purchase a book.
3. Download AudibleManager to your 

computer.
4. Activate your zūmo. The first time you 

open AudibleManager, you are led 
through the activation process. This is 
a one-time process.

5. Connect the zūmo to your computer.
6. Download the book to your computer.
7. Open AudibleManager and use it to 

transfer the book to your Garmin or 
SD card drive.

 TiP: Refer to AudibleManager’s 
Help file for detailed instructions. 
Select Help from the menu, and 
click Help.
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cUStoMizinG the zūmo
1. From the Menu page, touch .
2. Touch the setting you want to change. 

Each setting contains a submenu or a 
list.

Changing the Map Settings
Touch  >  Map. 

Map Detail—adjust the amount of detail 
shown on the map. Showing more detail 
may cause the map to redraw slower. 

Map View—change the perspective of 
the map. 
• Track Up—display the map in 2 

dimensions (2D) with your direction 
of travel at the top.

•  North Up—display the map in 2D 
with North at the top.

• 3D—display the map in 3 dimensions 
(3D) in Track Up. 

Vehicle—touch Change to change 
the icon used to show your position 
on the map. Touch the icon you want 
to use, and then touch oK. Download 
additional vehicle icons at www.garmin 
.com/vehicles.
Trip Log—touch Show to display your 
current trip log on the map as a thin blue 
line. To manage your trip log data, touch 

 > User Data > Manage Trip Log.
Map info—view the maps loaded on 
your zūmo and their version. Touch a 
map to enable (check mark) or disable 
(no check mark) that map. 

http://www.garmin.com/vehicles
http://www.garmin.com/vehicles
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Restore—restore the default map 
settings.

Changing the System 
Settings
Touch  >  System. 

GPS Mode—enable and disable GPS 
and WAAS/EGNOS. Turning on the 
WAAS/EGNOS setting might improve 
GPS accuracy, but it consumes more 
battery power. Go to www.garmin.com/
aboutGPS/waas.html for information 
about WAAS/EGNOS.
Safe Mode—turn Safe Mode on or off. 
When your vehicle is moving, Safe 
Mode disables all functions that require 
significant operator attention and could 
become a distraction while driving. 

Garmin Lock—turn on Garmin Lock 
to lock your zūmo. Enter a 4-digit PIN, 
and set a security location. For more 
information, see page 6.
About—display your zūmo’s software 
version number, unit ID number, and 
audio version number. You need this 
information when you update the system 
software (see page 44) or purchase 
additional map data (see page 45).
Restore—restore the default system 
settings.

Localizing Your zūmo
Touch  >  Locale. 

To change a setting, touch the button 
next to the icon. 

http://www.garmin.com/aboutGPS/waas.html
http://www.garmin.com/aboutGPS/waas.html
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To change all settings, touch Change 
All. In each screen, select the setting, 
and then touch oK. 
Locale—select your location.

 Text Language—set all on-screen 
text to the selected language. Changing 
the text language does not change the 
language of user-entered data or map 
data, such as street names. 

 Voice Language—set the language 
for voice prompts. Languages noted 
with a person’s name are text-to-
speech (TTS) voices, which have an 
extensive vocabulary and pronounce 
the street names as you approach 
turns. The prerecorded voices (those 
without a person’s name) have a limited 
vocabulary and do not speak names of 
locations or streets.

 Time Format—choose a 12-hour, 
24-hour, or UTC time format.
Time Zone—select a time zone or 
nearby city from the list. 
Daylight Saving—set to on, off , or 
Auto, if it is available.

 Units—set units of measure to 
Kilometers or Miles. 

Managing User Data
Touch  >  User Data. 

Set Home Location—enter or change 
your home location. See page 8. 
import Data—load Favorites, routes, 
trip logs, and pictures from your Garmin 
drive or SD card. 



�� BMW Motorrad zūmo Owner’s Manual

CustoMizing the zūMo

Manage Trip Log—view the current 
trip log usage. This is shown as a percent 
of the total available space. You can 
manage the most current 10,000 points 
of trip data on your zūmo. Beyond 
10,000 points, the zūmo moves the 
oldest trip data from the current log to 
an archive file on the zūmo’s internal 
memory. Archive files can store up 
to 1 MB each, and a maximum of 
20 archive files can be stored on the 
internal memory, depending on the space 
available. Using this method, the zūmo 
can store as many as 200,000 points of 
trip data for very long rides. 

	NoTE: Archived trip logs are 
intended to be used on your 
computer with MapSource, 
Google Earth, or myGarmin Web 
site. Archived trip logs are not 
visible on the zūmo.

To view available space in your Garmin 
drive, connect the zūmo to your 
computer, and select the Garmin drive. 
See page 29. 

• Clear Trip Log—reset the trip log 
before your next big trip. Clearing a 
large trip log may take a few minutes. 

• Save As Route—select and save a 
recent trip log as a route. This allows 
you to reuse recent trip data. For 
more information about routes, see 
page 12.

To view your trip log on the map, touch 
 > Map > Trip Log > Show. 

View Pictures—view pictures saved to 
your Garmin drive or SD card. Touch 
a thumbnail to view the image. Touch 
the image again to zoom using  and 

. Touch the picture and drag to view 
different parts of the picture.

To share pictures with another 
zūmo user:
1. Touch a thumbnail.
2. Touch Share. 
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3. Eject your SD card, and insert it into 
another zūmo.

4. A message appears. Touch Yes to 
import the shared picture.

5. Touch Pictures > touch a thumbnail 
> Import. 

Touch Slide Show to display each image 
for a few seconds and then display the 
next image. During the slide show, touch 
the screen at any time to stop and see 
more options.

Bluetooth Technology 
Settings
Touch  >  Bluetooth. 

Connect Phone—select Add Device 
> oK to pair with a mobile phone that 
has Bluetooth® wireless technology. See 
pages 19–25. 

	NoTE: The zūmo’s PIN code (or 
passkey) is 1234.

• Drop—select the phone you want to 
disconnect, and touch Yes. 

• Remove—select the phone you want 
to delete from the zūmo’s memory, 
and touch Yes. 

Phone Help—scroll through the list 
containing compatible devices. If 
your phone is not in this list, go to 
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www.garmin.com/bluetooth for more 
information.
Connect Headset—connect to a headset 
that has already been paired, or select 
Add Device. 
Bluetooth—enable and disable the 
Bluetooth component. The  Bluetooth 
icon appears on the Menu page if the 
Bluetooth component is enabled. To 
prevent a phone from automatically 
connecting, select Disabled.
Friendly Name—touch Edit to enter a 
friendly name that identifies your zūmo 
on devices with Bluetooth technology. 
Touch Done. 
Audio—specify which types of audio 
are sent to the Bluetooth headset. 
Restore—restore the default Bluetooth 
settings. Restoring the Bluetooth settings 
does not clear the pairing information.

Changing the Navigation 
Settings
Touch  >  Navigation. 

Route Preference—select a preference 
for calculating your route: 
• Faster Time—to calculate routes that 

are faster to drive but can be longer in 
distance. 

• Shorter Distance—to calculate 
routes that are shorter in distance but 
can take more time to drive. 

www.garmin.com/bluetooth
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• off Road—to calculate point-to-
point routes (without roads). On the 
map, touch  or press  to scroll 
to the Compass page.

Vehicle Type—specify your vehicle type 
to optimize routes. 
Avoidances—select the road types you 
want to avoid on your routes. The zūmo 
uses these road types only if alternative 
routes take you too far out of your way 
or if no other roads are available. If you 
have a traffic receiver or antenna, you 
can also avoid traffic incidents.
Attention Tone—turn on or off the 
attention tone.
Restore—restore the default navigation 
settings.

Customizing the Display
Touch  >  Display. 

Color Mode—select Daytime for a 
light background, Nighttime for a dark 
background, or Auto to automatically 
switch between the two. 
Splash Screen—select an image to be 
shown when you turn on the zūmo. First, 
load JPEG images. See pages 29–31. 
Brightness— raise and lower the 
backlight brightness using  and . 
Screen Shot—enable Screen Shot mode. 
Touch the  camera icon to take a 
picture of the screen. The picture bitmap 
file is saved in the Garmin\scrn folder 
on the Garmin drive. 
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Changing the Keyboard
Touch  >  Keyboard. 
Standard—displays a full alphabetic 
keyboard. 

Large Buttons—displays a large button 
touch-screen keyboard. This option is 
suited for motorcyclists wearing gloves. 
See page 9.
Auto—select to automatically switch 
between the standard keyboard when 
using the zūmo in the automotive mount 
(optional accessory) and the large button 
keyboard when using the zūmo in the 
motorcycle mount.

Managing Traffic Settings
Touch  >  > Traffic to 
view FM subscription information and 
settings. 

Restoring All Settings
Touch  > Restore > Yes. This 
restores all of the factory default 
settings.

Clearing All User Data
	CAUTioN: This deletes all  
user-entered information 
including Favorites, routes, trip 
logs, settings, and recent finds.

1. Hold your finger on the lower-right 
corner of the zūmo’s screen while 
turning on the zūmo. 

2. Keep your finger pressed until a 
message appears. 

3. Touch Yes. 
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zūmo Audio Options
	NoTE: Audio from MP3s is stopped during phone calls and navigation 
prompts. Navigation prompts are muted during phone calls.

Power
Source Audio Option

Na
vi

ga
tio

n 
Pr

om
pt

s

M
P3

Ph
on

e 

Notes

Motorcycle mount 
with external 
power

Wired headset 
or helmet with 
microphone

● ● ●

Bluetooth headset ● ● ●

Automotive mount 
with external 
power
(optional 
accessory)

Internal speaker 
and microphone

● ● ●

Wired headset or 
headphones with 
wired microphone

● ● ●

Bluetooth headset
and
internal speaker

○

●

○

●

●

-

Adjust volume on headset.

Adjust volume on zūmo.
Battery power Bluetooth headset ● ● ● Fully charged battery lasts up 

to 4 hours.
●  Audio available, ○  No audio available, -  Not applicable
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Charging the zūmo
1. Connect the power cable to a mount 

and a power source. 
2. Place the zūmo in the mount, and flip 

the lever down. 
OR
1. Charge the zūmo with the AC power 

cable. Plug the small end of the AC 
power cable into the mini-USB port 
on the bottom of the zūmo. 

2. Plug the other end into a standard 
wall outlet.

Resetting the zūmo
If your unit freezes up, press and hold 

 and press . 

Calibrating the Screen 
If the touch screen is not responding 
properly, calibrate the touch screen. 
Turn the unit off. Press and hold  for 
about one minute until the calibration 
screen appears. Follow the on-screen 
instructions.

Updating the zūmopdating the zūmo 
Software
1. Go to www.garmin.com/products/

webupdater to download the 
WebUpdater program to your 
computer. 

2. Connect the zūmo to your computer 
using the mini-USB cable.

M�n�-USB port for AC power, USB Mass 
Storage mode, and updat�ng software 

3. Run WebUpdater, and follow the 
screen prompts. After confirming 
that you want to perform an update, 
WebUpdater automatically downloads 
the update and installs it on your 
zūmo. 

4. Eject and unplug your zūmo (see 
page 31).

http://www.garmin.com/products/webupdater/
http://www.garmin.com/products/webupdater/
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Register your zūmo to receive 
notification of software and map 
updates. To register your zūmo, go to 
http://my.garmin.com. 
You can also download software updates 
from www.garmin.com/BMWzumo. 
Click Updates and Downloads, and 
follow the instructions. 

Purchasing and Loading 
Additional Map Data
To find out the version of the maps that 
are loaded on your zūmo, touch  
>  Map > Map info. To unlock 
additional maps, you need your unit ID 
and serial number. 
Check www.garmin.com/unlock/update 
.jsp to see if an update for your map 
software is available. 

You can also purchase additional map 
data from Garmin and load the maps to 
the internal memory or an optional SD 
card. 
Refer to the MapSource Help file 
for more information about using 
MapSource and loading maps and 
waypoints on your zūmo. 

Optional Accessories
For more information about optional 
accessories, go to www.garmin
.com/BMWzumo, and click Accessories. 
You can also contact your Garmin 
dealer to purchase accessories. Optional 
accessories include:
• Automotive mount
• Traffic receiver or antenna
• External remote antenna
• External microphone
• Extras (see pages 46–48) 

http://my.garmin.com
www.garmin.com/BMWzumo
http://www.garmin.com/unlock/update.jsp
http://www.garmin.com/unlock/update.jsp
www.garmin.com/BMWzumo
www.garmin.com/BMWzumo
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Connecting Accessories to 
Your zūmo
Some Garmin traffic receivers must be 
plugged into a mini-USB port on the 
zūmo mount. The microphone and audio 
out jacks are located on the left side of 
the zūmo mount.

M�crophone 
and aud�o 
out jacks

M�n�-USB 
port

	TiP: Carefully connect and 
disconnect cables. To disconnect, 
do not pull on the cable (cord), 
pull on the plug.

Garmin Travel Guide™ 
Much like a paper travel guide, the 
Garmin Travel Guide provides detailed 
information about locations, such as 
restaurants and hotels. To purchase the 
Travel Guide accessory, go to  
www.garmin.com/extras. 

To use the Travel Guide:
1. Insert the SD card into your zūmo. 
2. Touch  Where to >  Extras. 
3. Touch the Travel Guide. 
4. Touch a category. Touch a sub-

category, if necessary.
5. Touch a location in the list.
6. Do one of the following: 

Touch Go to go to the location. 
Touch Map to view this item on the 
map. 

http://www.garmin.com/extras
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Touch Save to save this location to 
your  Favorites. 
Touch More to view more information 
about the location. 

Safety Cameras
Safety camera information is available in 
some locations. (Check www.garmin 
.com/accessories/safetycamera for 
availability.) For these locations, your 
zūmo includes the locations of hundreds 
of safety cameras. Your zūmo alerts 
you when you are approaching a safety 
camera and can warn you if you are 
driving too fast. The data is updated at 
least weekly, so you always have access 
to the most up-to-date information.

To get updated safety camera 
information:
1. Go to http://my.garmin.com.
2. Sign up for a subscription.

You can purchase a new region at 
any time, and you can extend existing 
subscriptions at any time. Each region 
that you purchase has its own expiration 
date.

Custom POIs �Points ofPOIs �Points of 
Interest)
Load custom points of interest (POIs) 
onto your zūmo. POI databases are 
available from various companies on the 
Internet. Some custom databases contain 
alert information for points, such as 
school zones. A warning appears if you 
are traveling too fast near these custom 
POIs.
Use the Garmin POI Loader to load 
POIs on your Garmin drive or SD card. 
Download the POI Loader from  
www.garmin.com/extras.
Refer to the POI Loader Help file for 
more information; press F1 to open the 
Help file. 

www.garmin.com/accessories/safetycamera
www.garmin.com/accessories/safetycamera
http://my.garmin.com
http://www.garmin.com/extras
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To view your custom POIs, touch  
 Where to >  Extras >  

Custom Pois. 
To turn on or off custom POIs, touch 

 >  Proximity Points > 
Proximity Alerts. 
To delete the custom POIs from your 
zūmo, connect your zūmo to your 
computer. Open the Garmin\poi folder 
in the Garmin or SD card drive. Delete 
the file entitled poi.gpi.

 CAUTioN: Garmin is not 
responsible for the consequences 
of using a custom POI database 
or the accuracy of the safety 
camera or other custom POI 
database. 

Garmin TourGuide™ 
The Garmin TourGuide allows your 
zūmo to play third-party, GPS-guided 
audio tours. These audio tours can take 
you on a route while playing interesting 
facts about historical sites along the way. 
As you travel, the audio information 

is triggered by GPS signals. For more 
information, go to www.garmin.com/
extras and click Poi Loader.
To view your Garmin TourGuide files, 
touch  Where to >  Extras >  
Custom Pois. 
To change the Garmin TourGuide 
settings, touch  >  Proximity 
Points > TourGuide. Select Auto 
Play to hear the complete tour as 
programmed, Prompted to show the 
speaker icon  on the map when tour 
information is available during your 
route, or off. 

SaversGuide®

The SaversGuide is an optional 
accessory that is available only in North 
America (www.garmin.com/extras). 
With the SaversGuide preprogrammed 
SD data card and membership card, 
your zūmo is a digital coupon book that 
notifies you of merchants near your 
current location where you are eligible 
for a discount, such as restaurants, 
hotels, and movie theaters.

http://www.garmin.com/extras
http://www.garmin.com/extras
http://www.garmin.com/extras
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Battery Information 
	NoTE: See the Important Safety 
and Product Information guide 
for additional battery information 
and warnings.

Your zūmo contains an internal lithium-
ion battery. The battery lasts up to 4 
hours, depending on usage. 
The  battery icon on the Menu 
page indicates the status of the internal 
battery. If the icon is not present, your 
zūmo is connected to external power. For 
information about charging your zūmo, 
see page 44.

Maximizing the Battery Life
• Turn off GPS (  >  System  

> GPS Mode > GPS off) when you 
do not need to receive GPS signals, 
or use Normal mode when WAAS or 
EGNOS is not available.

• Turn the backlight brightness down. 
Press and hold , and then use  
and  to adjust the brightness. 

• Do not leave your zūmo in direct 
sunlight. Avoid prolonged exposure 
to excessive heat or cold. 

Replacing the Battery
To purchase a replacement lithium-ion 
battery pack, go to www.garmin.com/
BMWzumo, and click Accessories.  
Unscrew the battery pack and replace 
the battery. Contact your local waste 
disposal department for information on 
properly disposing of the battery. 

MCX 
connector 

under 
weather cap 

Battery 
pack

Screw

www.garmin.com/BMWzumo
www.garmin.com/BMWzumo
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Using a Remote Antenna
You can use an optional external remote 
antenna (Garmin GA 25MCX). To 
purchase, go to www.garmin.com/
BMWzumo, and click Accessories. 
Pull back the weather cap from the MCX 
connector located on the back of the 
zūmo, and connect the antenna. 

Caring for Your zūmo 
Your zūmo contains sensitive electronic 
components that can be permanently 
damaged if exposed to excessive shock 
or vibration outside normal motorcycle 
or automobile use. To minimize the 
risk of damage to your zūmo, avoid 
dropping your unit and operating it in 
extreme high-shock and high-vibration 
environments.
 

Cleaning the Unit
The zūmo is constructed of high-
quality materials and does not require 
user maintenance other than cleaning. 
Clean the unit’s outer casing (not the 
touch screen) using a cloth dampened 
with a mild detergent solution, and 
then wipe dry. Avoid chemical cleaners 
and solvents that can damage plastic 
components.

Cleaning the Touch Screen
Clean the touch screen with a soft, clean, 
lint-free cloth. Use water, isopropyl 
alcohol, or eyeglass cleaner, if needed. 
Apply the liquid to the cloth, and then 
gently wipe the touch screen.

Protecting Your zūmo
• Carry and store your zūmo in the 

included carrying case. 
• Do not store your zūmo where 

prolonged exposure to extreme 
temperatures can occur (such as in 
the trunk of a car), because it can 
cause permanent damage. 

www.garmin.com/BMWzumo
www.garmin.com/BMWzumo


BMW Motorrad zūmo Owner’s Manual ��

aPPendix

• Though a PDA stylus can also be 
used to operate the touch screen, 
never attempt this while operating 
a vehicle. Never use a hard or sharp 
object to operate the touch screen or 
damage may result. 

Avoiding Theft
• To avoid theft, remove the zūmo and 

mount from sight when not in use. 
• Use the Garmin Lock™ feature. See 

page 6.

About GPS Satellite SignalsSatellite Signals
Your zūmo must acquire GPS (Global 
Positioning System) satellite signals 
to operate. If you are indoors, near tall 
buildings or trees, or in a parking garage, 
your zūmo cannot acquire satellites. 
Go outside to an area free from tall 
obstructions to use your zūmo. 
When your zūmo has acquired satellite 
signals, the signal strength bars on the 
Menu page are green . When it 
loses satellite signals, the bars turn red or 
clear . 
For more information about GPS, go to 
www.garmin.com/aboutGPS.

http://www.garmin.com/aboutGPS
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Specifications
Physical size: 4.4” W x 3.2” H x  
2.87” D (11.3 x 8.2 x 7.2 cm)
Weight: 0.59 pounds (269 g)
Display: 2.8” W x 2.1” H (7.2 x 5.4 cm); 
320 x 240 pixels; bright, 16-bit LCD, 
with white backlight and touch screen
Case: IPX7 waterproof
Temperature range: 32°F to 140°F 
(0°C to 60°C)
Data storage: Internal memory and 
optional removable SD card. Data stored 
indefinitely.
Computer interface: USB mass storage, 
plug-and-play
Charge time: Approximately 6 hours
Power input: DC vehicle power cable or 
AC power cable. 
Usage: 15 W max. @ 13.8 VDC
Battery life: up to 4 hours depending on 
usage

GPS Performance 
Specifications
Receiver: WAAS enabled
Acquisition times*: 
Warm: < 1 sec 
Cold: < 38 sec 
Factory Reset: < 45 sec
*On average for a stationary receiver 
with a clear view of the sky
Update rate: 1/sec, continuous
GPS accuracy:
Position: < 10 meters, typical
Velocity: 0.05 meter/sec RMS
GPS (WAAS) accuracy:
Position: < 5 meters, typical
Velocity: 0.05 meter/sec RMS
For a complete list of specifications, go 
to www.garmin.com/BMWzumo, and 
click Specifications.

www.garmin.com/BMWzumo
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zūmo Troubleshooting
Problem/Question Solution/Answer

The zūmo does not 
acquire satellite 

signals.

It can take a few minutes to acquire satellite signals. Go to an 
open area, out of garages, and away from tall buildings. Stop 
your vehicle, and position the zūmo where there is a clear 
view of the sky. The bars in the upper-left corner  indicate 
satellite strength. 

How do I clear all my 
user data?

Hold your finger on the lower-right corner of the zūmo’s screen 
while turning on the zūmo. Keep your finger pressed until the 
message appears. Touch Yes to clear all user data. 

The zūmo is locked 
up/frozen. To reset your zūmo, press and hold  and press .

My battery gauge does 
not seem accurate.

Allow the unit to fully discharge, and then fully charge it (without 
interrupting the charge cycle).

The touch screen is not 
responding to my taps 

properly.

Calibrate the touch screen. Turn the unit off. Press and hold  
for about one minute until the Calibration page appears. Follow 
the on-screen instructions.

My Bluetooth device 
will not connect to the 

zūmo. 

Verify that the Bluetooth field is set to Enabled. Make sure your 
Bluetooth device is turned on and is less than 10 meters (about 
33 feet) away from your zūmo. Go to www.garmin.com/bluetooth 
for a list of compatible phones and headsets.

www.garmin.com/bluetooth
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USB Interface Troubleshooting
Problem/Question Solution/Answer

How do I know my 
zūmo is in USB Mass 

Storage Mode?

When your zūmo is in USB Mass Storage Mode, a picture of a 
zūmo connected to a computer is shown. Also, you should see 
a new removable disk drive listed in My Computer (Windows) or 
a new volume (drive) on your desktop (Mac). 

My computer never 
senses that the zūmo is 

connected.

1. Unplug the USB cable from your computer. 
2. Turn the zūmo off. 
3. Plug the USB cable into your computer and your zūmo. 

The zūmo automatically turns on and goes into USB Mass 
Storage Mode. 

I cannot find any drives 
named “Garmin” in my 

list of drives.

If you have several network drives mapped on your computer, 
Windows may have trouble assigning drive letters to your 
Garmin or SD drives. Follow the steps on the next page to 
assign (map) your drive letters. 

I get a message saying 
“Unsafe Removal of 

Device” when I unplug 
the USB cable.

Windows: Double-click the Unplug or Eject  icon in your 
system tray. Select USB Mass Storage Device and click Stop. 
Select the Garmin drive and click OK. You can unplug your 
zūmo now. 
Mac: Drag the volume icon to the Trash. The Trash icon 
changes to an Eject icon. You can unplug your zūmo now.
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Problem/Question Solution/Answer

How can I rename 
my Garmin drives in 

Windows?

1. Open My Computer. 
2. Select the drive you want to rename. 
3. Right-click your mouse, and select Rename. 
4. Type the new name, and press the Enter key on your 

computer’s keyboard. 

How do I assign (map) 
my Garmin drives indrives in 

Windows?

1. Turn off your zūmo. 
2. Plug the USB cable into the zūmo and your computer. Your 

zūmo automatically turns on. 
3. Click Start > Settings > Control Panel > Administrative 

Tools > Computer Management > Storage > Disk 
Management. 

4. Click a zūmo removable disk drive (either the internal 
memory or your SD card drive). Right-click your mouse, and 
select Change Drive Letter and Path.

5. Select Edit, select a drive letter from the drop-down list, and 
click OK. 
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Symbols
2-D, 3-D map view 35
A
About button 36
accessories 45
address 7
add a stop 5
alerts, safety camera 47
antennas 45, 50
anti-theft feature 6, 36
audio

jacks 46
options 43
version 36

avoiding
road types 41
traffic 41

B
battery 49, 52
Bluetooth technology 19–25

PIN 20
settings 39–42

brightness 2, 41
browsing the map 14
C
calibrating the touch screen 44
calling home 24
call history 24

call waiting 22
caring for your zūmo 50
charging the zūmo 44
clearing user data 42
Compass page 18, 41
computer connection 29
contact Garmin i
coordinates 15, 16
current location, saving 11
customizing your zūmo 35–42
Custom POIs 47
D
data storage drives 29, 52
daylight saving 37
Declaration of Conformity iv
deleting

all user data 42
character 9
custom POIs 48
Favorites 12, 13
files 31

detail maps 35
detours 6
diacritical characters 9
display settings 41
drives, Garmin 30
driving directions 18
E
editing saved places 11
EGNOS 36
ejecting the USB 31

elevation 16
ending a call 21
expanding your search 15
Extras 46–47
F
Favorites 10

editing 11
finding 11
saving 10
sharing 10

FCC compliance iv
files

deleting 31
managing 29, 37
supported types 31
transferring 29–31

finding places
by address 7
by coordinates 15
by name 9
by postal code 7
intersection 7
item on the map 14
near another location 15
saved places (Favorites) 11

fuel gauge 17
G
Garmin Lock 6, 36, 51
Garmin TourGuide

playing files 48
Garmin Travel Guide 46
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going home 8–15
Google Earth i
Go page 7
GPS 3, 51
H
hands-free features 19–25
headsets 19, 43
home location 8
I
importing data 37
intersection 7
K
keyboard 9, 42
kilometers 37
L
languages 37
loading additional maps 45
locking your zūmo 6
M
managing files 29–31
map

browse 14
customize 35
Map Info button 35
moving 14
update maps 44
using the Map page 14, 16
version 35
view 14, 35
zoom 14

MapSource i, 29, 45
menu page 3
miles 37
mini-USB. See USB
MP3 files

loading 29
playing 32

mute a call 21
myGarmin i, 45, 47
N
navigation settings 40
Near button 15
Next Turn page 18
North Up map view 35
O
off road, routing 13, 41
P
pairing a headset 20
pairing a mobile phone 20
phone book 23
phone calls 21
picture viewer 38
PIN

Bluetooth 39
Garmin Lock 6

playing music 32
POIs, custom 47
position icon 16, 35
postal code 7

R
recently found location 10
registering your zūmo 45
remote antenna 50
removable disk drive 30
removing/deleting a phone 39
resetting

the trip data 17
your zūmo 44

restoring settings 42
routes 12–14
routing preferences 40
S
safety cameras 47
Safe Mode 36
satellite signals 3, 51
SaversGuide 48
saving

places you find 8, 10
routes 12
your current location 11, 14

school zone database 47
Screen Shot mode 41
SD card 1, 29, 52

sharing 10, 13
security location 6
settings 35–42
setting your location 8, 14
show map 8, 18
slide show 39
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software
updating 44
version 36

special characters 9
specifications 52
spelling the name of a place 9
splash screen 41
storing your zūmo 50
supported file types 29
system settings 36
T
text language 37
time format 37
time zone 37
tones 41
touch screen

aligning 44
cleaning 50

Track Up map view 35
traffic

avoiding 27, 41
incidents 27
settings 42
subscriptions 28

transferring files 29–31
Trip Information page 17
trip log 38
troubleshooting 53–55
turn-by-turn directions 18
Turn List page 18

U
unit ID 36
updating

maps 45
zūmo software 44

USB
mass storage mode 29–31
ports 1, 29, 44, 46
troubleshooting 53

user data 37
V
vehicle icon 16, 35
vehicle type 41
view pictures 38
voice dial 25
voice language 37
volume 2
W
WAAS 36
WebUpdater 44
Z
zoom 14, 16, 38
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© 2007 Garmin Ltd. or its subsidiaries
Garmin International, Inc. 

1200 East 151st Street, Olathe, Kansas 66062, USA
Garmin (Europe) Ltd. 

Liberty House, Hounsdown Business Park, Southampton, Hampshire, SO40 9RB UK
Garmin Corporation 

No. 68, Jangshu 2nd Road, Shijr, Taipei County, Taiwan
www.garmin.com

Part Number 190-00777-00 Rev. A

www.garmin.com
www.garmin.com

	Preface
	Manual Conventions
	Contact Garmin
	myGarmin™ 
	About Google Earth™ 
	Important Information

	Getting Started
	Looking at Your zūmo
	Quick Links
	zūmo Tips and Shortcuts
	Adjusting the Volume
	Adjusting the Brightness
	Configuring Your zūmo
	Acquiring Satellites
	Using Your zūmo
	Finding Your Destination 
	Following Your Route
	Adding a Stop
	Adding a Detour
	Stopping the Route
	Locking Your zūmo

	Where to
	Finding an Address
	Go Page Options
	Go Home
	Finding Points of Interest
	Recently Found Locations
	Favorites
	Creating a Saved Route
	Finding a Location Using the Map
	Entering Coordinates
	Expanding Your Search

	Using the Main Pages
	Map Page
	Trip Information Page
	Turn List Page
	Next Turn Page
	Compass Page

	Using Hands-free Features
	Pairing Your Device
	Getting a Call
	Phone Menu

	Traffic Information
	Traffic in Your Area
	Traffic on Your Route
	Traffic Codes and Symbols
	Purchasing Traffic Subscriptions

	Managing Files on Your zūmo
	Supported File Types
	Deleting zūmo Files

	Using the Media Player
	Listening to MP3 Files 
	Listening to Audible Books

	Customizing the zūmo
	Changing the Map Settings
	Changing the System Settings
	Localizing Your zūmo
	Managing User Data
	Bluetooth Technology Settings
	Changing the Navigation Settings
	Customizing the Display
	Changing the Keyboard
	Managing Traffic Settings
	Restoring All Settings
	Clearing All User Data

	Appendix
	zūmo Audio Options
	Charging the zūmo
	Resetting the zūmo
	Calibrating the Screen 
	Updating the zūmo Software
	Purchasing and Loading Additional Map Data
	Optional Accessories
	Battery Information 
	Using a Remote Antenna
	Caring for Your zūmo 
	About GPS Satellite Signals
	Specifications
	zūmo Troubleshooting
	USB Interface Troubleshooting

	Index

